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 Supported version TOP Design Studio V4.9 or higher  
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We want to thank our customers who use the Touch Operation Panel. 
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1. System configuration 

The system configurations of TOP and "Robots and Design – WTR Controller Series Ethernet" are as follows: 

 

Series CPU Communication method System setting Cable 

Robots and Design WTR Controller 
Ethernet  

(TCP / UDP)  
 

3. TOP communication 

setting 

4. External device 
 

Twisted pair cable  

*Note 1) 
  

 

*Note 1) Twisted pair cable 

- Refer to STP (Shielded Twisted Pair Cable) or UTP (Unshielded Twisted Pair Cable) Category 3, 4, 5. 

- Depending on the network configuration, you can connect to components such as the hub and transceiver, and in this case, use a 

direct cable. 

 

 

■ Connectable configuration 

 

ㆍ1:1 connection (one TOP and one external device) connection 

 

 

ㆍ1:N connection (one TOP and multiple external devices) connection 
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2. External device selection 

■ Select a TOP model and a port, and then select an external device. 
 

 

 
 

 
 

 

Settings Contents 

TOP Model Check the display and process of TOP to select the touch model. 

External device Vendor Select the vendor of the external device to be connected to TOP. 

Please select "Robots and Design". 

PLC Select the external device to be connected to the TOP. 
 

Model Interface Protocol 

WTR Controller Ethernet RoboTocol ETH 

 

Please check the system configuration in Chapter 1 to see if the external device you want to 

connect is a model whose system can be configured. 
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3. TOP communication setting 

The communication can be set in TOP Design Studio or the TOP main menu. The communication should be set in the same way as 

that of the external device. 
 

3.1 Communication setting in TOP Design Studio 

(1) Communication interface setting 

■ [Project > Project Property > TOP Setting] → [Project Option > "Use HMI Setup" Check > Edit > Ethernet] 

– Set the TOP communication interface in TOP Design Studio. 
 

 
 

 
 

Items TOP External device Remarks 

IP Address *Note 1) Note 2) 192.168.200.100 192.168.200.4  

Subnet Mask 255.255.255.0 255.255.255.0  

Gateway 192.168.0.1 192.168.0.1  

*Note 1) The network addresses of the TOP and the external device (the first three digits of the IP, 192 . 168 . 200 . 0) should match. 

*Note 2) Do not use duplicate IP addresses over the same network. 

* The above settings are examples recommended by the company. 

 

Items Description 

IP Address Set the IP address of the TOP. 

Subnet Mask Enter the subnet mask of the network. 

Gateway Enter the gateway of the network. 
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(2) Communication option setting 

■ [Project > Project Property > Device Setting > ETHERNET > "PLC1 : Robots and Design"] 

– Set the options of the WTR Controller Series Ethernet communication driver in TOP Design Studio. 
 

 

 

Items Settings Remarks 

Interface Select “Ethernet”. Refer to “2. External 

device selection”. Protocol Select "RoboTocol ETH". 

IP  Enter the IP address of an external device.  

Ethernet Protocol Select the Ethernet protocol between the TOP and an external device.  

Port Enter the Ethernet port number of an external device.  

TimeOut (ms) Set the time for the TOP to wait for a response from an external device.  

SendWait (ms) Set the waiting time between TOP's receiving a response from an external device and 

sending the next command request. 
 

Stage Enter the address of the internal System Buffer in which the Stage value is saved.  

Slot Enter the address of the internal System Buffer in which the Slot value is saved.  

Arm Enter the address of the internal System Buffer in which the Arm value is saved.  

Finger Enter the address of the internal System Buffer in which the Finger value is saved.  
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3.2. Communication setting in TOP  

* This is a setting method when "Use HMI Setup" in the setting items in "3.1 TOP Design Studio" is not checked. 
 

■ Touch the top of the TOP screen and drag it down. Touch "EXIT" in the pop-up window to go to the main screen.  

   

(1) Communication interface setting 

■ [Main Screen > Control Panel > Ethernet] 
 

 

 

Items TOP External device Remarks 

IP Address *Note 1) Note 2) 192.168.200.100 192.168.200.4  

Subnet Mask 255.255.255.0 255.255.255.0  

Gateway 192.168.0.1 192.168.0.1  

*Note 1) The network addresses of the TOP and the external device (the first three digits of the IP, 192 . 168 . 200 . 0) should match. 

*Note 2) Do not use duplicate IP addresses over the same network. 

* The above settings are examples recommended by the company. 

 

 

Items Description 

IP Address Set the IP address of the TOP. 

Subnet Mask Enter the subnet mask of the network. 

Gateway Enter the gateway of the network. 
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 (2) Communication option setting 

■ [Main Screen > Control Panel > PLC] 
 

 

Items Settings Remarks 

Interface Select “Ethernet”. Refer to “2. External 

device selection”. Protocol Select "RoboTocol ETH". 

IP  Enter the IP address of an external device.  

Ethernet Protocol Select the Ethernet protocol between the TOP and an external device.  

Port Enter the Ethernet port number of an external device.  

TimeOut (ms) Set the time for the TOP to wait for a response from an external device.  

SendWait (ms) Set the waiting time between TOP's receiving a response from an external device 

and sending the next command request. 
 

Stage Enter the address of the internal System Buffer in which the Stage value is saved.  

Slot Enter the address of the internal System Buffer in which the Slot value is saved.  

Arm Enter the address of the internal System Buffer in which the Arm value is saved.  

Finger Enter the address of the internal System Buffer in which the Finger value is saved.  
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3.3 Communication diagnostics 

■ Check the interface setting status between the TOP and an external device. 

- Touch the top of the TOP screen and drag it down. Touch “EXIT” in the pop-up window to go to the main screen. 

- Check if the ETH port settings you want to use in [Control Panel > Ethernet] are the same as those of the external device. 

 

■ Diagnosis of whether the port communication is normal or not 

- Touch "Communication diagnostics" in [Control Panel > PLC]. 

- The Diagnostics dialog box pops up on the screen and determines the diagnostic status. 

OK Communication setting normal 

Time Out Error Communication setting abnormal 

- Check the cable, TOP, and external device setting status. (Reference: Communication diagnostics sheet) 

 

■ Communication diagnostics sheet 

- If there is a problem with the communication connection with an external terminal, please check the settings in the sheet below. 

Items Contents Check Remarks 

System 

configuration 

How to connect the system OK NG 
1. System configuration 

Connection cable name OK NG 

TOP Version information OK NG 

2. External device selection 

3. Communication setting 

Port in use OK NG 

Driver name OK NG 

Other detailed settings OK NG 

Relative prefix Project setting OK NG 

Communication 

diagnostics 
OK NG 

Ethernet port setting IP Address OK NG 

Subnet Mask OK NG 

Gateway OK NG 

External device CPU name OK NG 

4. External device setting 

Communication port name (module name) OK NG 

Protocol (mode) OK NG 

Setup Prefix OK NG 

Other detailed settings OK NG 

Ethernet port setting IP Address OK NG 

Subnet Mask OK NG 

Gateway OK NG 

Check address range  

OK NG 

5. Supported addresses 

(For details, please refer to the PLC 

vendor's manual.) 
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4. External device setting 
 

For more detailed setting method than that described in this example, refer to the PLC user manual. 
 

 
Do not use duplicate IP addresses over the unit network. 
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5. Supported addresses 

The devices available in TOP are as follows:  

The device range (address) may differ depending on the CPU module series/type. The TOP series supports the maximum address 

range used by the external device series. Please refer to each CPU module user manual and take caution to not deviate from the 

address range supported by the device you want to use. 
 

Device Bit Address Word Address Comment Remark 

VER 0.00 – 40.15 0 – 40 
Read controller version 

Read controller version (using string) 

 

R 

SERVO 0.00 – 0.15 0 – 0 

Servo power 

Read : Reads the current servo status value.  

Write :  

1 >>  

Supply the power to the servo.  

0 >> 

Disconnect the power to the servo.  
 

 

 

 

 

 

ERR 0.00 – 0.15 0 – 0 
Read error code 

Read current error code. 

 

R 

ERRRESET 0.00 – 0.15 0 – 0 
Error reset 

Clear the error status, which occurs now. 

 

W 

NMPS 1.00 – 6.15 1 – 6 

(Motor coordinate system) Read current 

position 

Requires the robot's current motor coordinate position. 

 

R  

32BIT 

NPOR 
1–999:1–5.00 – 

1–999:1–5.31 

1–999:1–5 – 

1–999:1–5 

Read saved teaching data 

Read the saved teaching data (POINTDATA). 

 

R  

32BIT 

_NPOR 
1–999:1–6.00 – 

1–999:1–6.31 

1–999:1–6 – 

1–999:1–6 

Register saved teaching data 

Does not communicate and has only a value. 

Communicates with this value and writes teaching data 

(POINT DATA) when using POA. 

 

 

32BIT 

POA 1.00 –999.31 1 –999 

Enter POINT DATA 

Enters POINT data. 

 

W 

32BIT  

TI 1.00 –999.15 1 –999 
Teaching interlock 

Teaching interlock 

 

NIDO 1.00–999.15 1–999 

Read OUTPUT signal status 

Reads the current OUTPUT signal status starting from 

the specified channel number. 

 

R 

32BIT 

NIDI 1.00–999.15 1–999 

Read INPUT signal status 

Reads the current INPUT signal status starting from the 

specified channel number. 

 

R 

32BIT 

IDO 1.00–999.15 1–999 

Signal status of INPUT whose address has been 

translated 

Current OUTPUT signal status whose address has been 

translated starting from the specified channel number  

 

32BIT 
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Device Bit Address Word Address Comment Remark 

IDI 1.00–999.15 1–999 

Read signal status of INPUT whose address has 

been translated 

Reads signal status of INPUT whose address has been 

currently translated starting from the specified channel 

number. 

 

R 

32BIT 

RIDO 1.00–999.15 1–999 

Read external I/O OUTPUT signal status 

Reads the status of the OUTPUT signal of the 

expansion I/O board. 

 

R 

32BIT 

RIDI 1.00–999.15 1–999 

Read external I/O INPUT signal status 

Reads the status of the INPUT signal of the expansion 

I/O board. 

 

R 

32BIT 

ORG 0.00 – 0.15 0 – 0 

Robot initialization and homing 

- Performs homing operation along with robot 

initialization operation. 

- Originates from the coordinates saved in teaching 

data No. 498. 

- After supplying the power to the controller, the 

robot initialization operation shall be performed 

once. 

 

 

 

W 

HOME 0.00 – 0.15 0 – 0 

Homing 

- Performs homing operation.  

- Originates from the coordinates saved in teaching 

data No. 498. 

 

 

W 

JOG 1.00 – 6.15 1 – 6 

JOG operation 

- Performs JOG move for the designated axis.  

- Immediately from the moment the command is 

received, the device continues to move until the 

device reaches the soft limit of the 

corresponding axis or the limit sensor. 

 

 

W 

FMD 1.00 – 6.15 1 – 6 
Set axis's free mode 

Activates the free mode of the designated axis. 

 

W 

NMMI 0.00 – 0.15 0 – 0 

Robot's relative movement 

Performs relative movement for each axis of the robot 

by a specified value. 

 

W 

_NMMI 0.00 – 6.31 0 – 6 

Register Robot's relative movement 

The device does not communicate, only has values. 

When using NMMI, the device communicates with this 

value and performs relative movement as much as the 

value. 

 

 

32BIT 

NMMA 0.00 – 0.15 0 – 0 

Robot's absolute movement 

Performs absolute movement for each axis of the robot 

by a specified value. 

 

W 
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Device Bit Address Word Address Comment Remark 

_NMMA 0.00 – 6.31 0 – 6 

Register Robot's absolute movement 

The device does not communicate, only has values. 

When using NMMI, the device communicates with this 

value and performs relative movement as much as the 

value. 

 

32BIT 

RETA 0.00 – 0.15 0 – 0 

Robot's hand folding motion 

The robot performs the motion of folding the 

designated hand at the current position. 

 

W 

Refer to 

Arm- DATA. 

EXTA 0.00 – 0.15 0 – 0 

Robot's hand extending motion 

- The robot performs the motion of extending the 

hand at the current position.  

- After the READY motion (GRDY or PRDY or TRDY), 

the robot must perform the arm stretching motion. 

 

W 

Refer to 

Stage, arm 

DATA. 

GRDY 0.00 – 0.15 0 – 0 

GET motion READY operation 

During the GET motion, even the motion just before 

extending the arm is performed. 

Refer to W 

Stage, 

slot,arm 

DATA. 

PRDY 0.00 – 0.15 0 – 0 

PUT motion READY operation 

During the PUT motion, even the motion just before 

extending the arm is performed. 

Refer to W 

Stage, 

slot,arm 

DATA. 

TRDY 0.00 – 0.15 0 – 0 

READY operation in teaching position 

This is a motion to check the teaching position, and 

perform the motion just before extending the arm to 

the teaching position. 

Refer to W 

Stage, 

slot,arm 

DATA. 

GET 0.00 – 0.15 0 – 0 

GET operation 

Performs the action to bring the wafer. 

 

Refer to W 

Stage, 

slot,arm 

DATA. 

PUT 0.00 – 0.15 0 – 0 

PUT operation 

Performs an action to put the wafer down. 

 

Refer to W 

Stage, 

slot,arm 

DATA. 

SGET 0.00 – 0.15 0 – 0 

Check only specific blade sensor of HAND 

upon GET operation 

Checks only wafer sensor of some blade and performs 

5 Hand GET operation. 

Refer to 

Stage, slot, 

Finger 

DATA. 

SPUT 0.00 – 0.15 0 – 0 

Check only specific blade sensor of HAND 

upon PUT operation 

Checks only wafer sensor of some blade and performs 

5 Hand GET operation. 

Refer to 

Stage, slot, 

Finger 

DATA. 

POM 0.00 – 0.15 0 – 0 

Safe movement to a specific teaching position 

Moves the robot to the position of specific point data. 

 

 

W 
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Device Bit Address Word Address Comment Remark 

ASS 0.00 – 0.15 0 – 0 

Stop motion 

Decelerates and stop all axes immediately during 

movement. 

 

W 

AES 0.00 – 0.15 0 – 0 
Stop motion and servo down 

Stops all axes immediately during movement. 

 

W 

PAUSE 0.00 – 0.15 0 – 0 

Pause motion 

Pause the robot during movement.  

0 Resume motion 

1 Pause  

 

W 

DEM 0.00 – 0.15 0 – 0 

Read demo mode status 

Reads the current demo mode settings.  

Reads 1 for demo mode, 

Reads 0 for sensor mode. 

 

 

R 

LDM 0.00 – 0.15 0 – 0 

Read interlock check set value 

Reads the current interlock status.  

Reads 1 for interlock mode, 

and otherwise reads 0. 

 

R 

SSL 0.00 – 0.15 0 – 0 
Set the number of stage slots 

Maximum number of slots in the corresponding stage 

Refer to 

Stage DATA. 

SPI 0.00 – 0.15 0 – 0 
Set Stage slot pitch 

Slot pitch of the corresponding stage 

Stage 

DATA. 

VDP 0.00 – 0.15 0 – 0 V-axis position  

HMS 1.00 – 6.15 1 – 6 
Homing speed  

Robot's origin motion speed 

 

HIS 1.00 – 6.15 1 – 6 

WAFER ON speed  

If there is a wafer, the robot's speed % value upon GET 

and PUT commands 

 

LOS 1.00 – 6.15 1 – 6 

WAFER OFF speed  

If there is no wafer, the robot's speed % value upon 

GET and PUT commands 

 

ZSP 0.00 – 1.15 0 – 1 

Z axis UP/DOWN speed 

The speed at which the robot's Z-axis moves when 

placing the wafer in the slot after the robot extends its 

hand during GET/PUT motion. 

 

_ZSP 0.00 – 1.15 0 – 1 

Register Z axis UP/DOWN speed 

The device does not communicate, only has a value. the 

device has UP,DOWN values. 

 

SPD 0.00 – 1.15 0 – 1 
System speed 

Controls the speed of the entire robot. 

 

JSP 1.00 – 6.15 1 – 6 
Jog speed 

Robot's jog speed 

 

MST 1.00 – 6.15 1 – 6 

Motor acceleration/deceleration time 

Set the time it takes for the motor for each axis to 

accelerate from a stopping status to the maximum 

speed or to decelerate from maximum speed to 

stopping. 
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Device Bit Address Word Address Comment Remark 

_MST 1.00 – 6.15 1 – 6 

Register motor acceleration/deceleration time 

The device does not communicate, only has values. This 

is used to write a MST command. 

 

RMSP 1.00 – 6.15 1 – 6 
Read motor speed for each axis 

Calls up the currently set motor speed for each axis. 

 

R 

RMAC 1.00 – 6.15 1 – 6 
Read motor acceleration for each axis 

Calls up the currently set axis motor acceleration. 

 

R 

VDP 0.00 – 0.15 0–0 V-axis position   

ADR 0.00–3.15 0–3 Controller IP  

_ADR 0.00–3.15 0–3 Register controller IP  

TIP 0.00 – 0.15 0–0 Controller PORT number  

FZS 0.00 – 0.15 0–0 

Set the origin of each axis 

Sets the current robot's position as the origin for the specified 

axis. 

W 

LIMIT 1–6,0–3.15 1–6,0–3 

Set each axis's soft limit 

1–6: axis 

0–3: 

Hard limit max 

Hard limit min 

Soft limit max 

Soft limit min 

 

 

32BIT 

_LIMIT 1–6,0–3.15 1–6,0–3 

Register each axis's soft limit 

The device does not communicate, only has values. 

When using LIMIT, the device communicates with this 

value and changes as much as the value. 

32BIT 

MAP 0.00 – 0.15 0–0 

Mapping command list 

Maps the status of wafers contained the cassettes of the 

corresponding stage. 

Refer to 

Stage 

DATA. 

MPT 0.00 – 0.15 0–0 

Detect protruded wafer 

Detects the protruded wafers contained the cassettes of the 

corresponding stage. 

Stage 

DATA. 

MLD 0.00 – 0.15 0–0 

Mapping calibration 

This is a command to process the result data of mapping after 

the MAP command. 

 

W 

MPS 0.00 – 0.15 0–0 

Mapping speed 

Read: reads the speed of the part which corresponds to the Z 

UP motion upon the currently set mapping operation. 

Write: specifies the speed of the part which corresponds to 

the Z UP motion upon mapping operation. 

 

WWTH 0.00 – 0.15 0 – 0 

Wafer thickness 

Sets the thickness value for the reference of the wafer 

thickness upon mapping. 

Refer to 

Stage 

DATA. 

WSCT 0.00 – 0.15 0 – 0 

Cross discrimination criteria 

Sets the criteria range of wafer cross discrimination.  

Refer to 

Stage 

DATA. 

WSDT 0.00 – 0.15 0 – 0 

Double discrimination criteria 

Sets the wafer double discrimination criteria. 

Refer to 

Stage 

DATA. 



 

 External device connection manual for TOP Design Studio 15 / 15 

Device Bit Address Word Address Comment Remark 

DM 0.00 – 0.15 0 – 0 
Use double mapping 

Set Double Mapping Mode. 

 

DMD 0.00 – 4.15 0 – 4 

Step length for protrusion detection 

Set protrusion detection step length of the corresponding 

stage 

 

MRDY 0.00 – 0.15 0 – 0 

Mapping Ready operation 

Protocol for testing the operation of mapping on the 

corresponding station 

Refer to 

Stage 

DATA. 

W 

MEXTA 0.00 – 0.15 0 – 0 

Extend mapping arm 

Protocol for testing the operation of mapping on the 

corresponding station 

Refer to 

Stage 

DATA. 

W 

MZDOWN 0.00 – 0.15 0 – 0 

Raise mapping z-axis 

Protocol for testing the operation of mapping on the 

corresponding station 

Refer to 

Stage 

DATA. 

W 

MRETA 0.00 – 0.15 0–0 

Fold mapping arm 

Protocol for testing the operation of mapping on the 

corresponding station 

 

DMRD 0.00 – 0.15 0–0 Ready operation for protrusion detection W 

DMAD 0.00 – 0.15 0–0 Arm Extend for protrusion detection W 

DMZU 0.00 – 0.15 0–0 Z-axis motion for protrusion detection W 

WXUS 0.00 – 0.15 0–0 

XY SELECT  

0 : W 

1 : X 

 

TPIDI 0.00 – 0.15 0–0 TPIDI bit field value  

WZPC 0.00 – 0.15 0–0 Position Calibration  

MAO 0.00 – 0.15 0–4 Motor Speed  R 

_MAO 0.00 – 0.15 0–4 

Register Motor Speed 

The device does not communicate, only has values. This 

is used to write a MAO. 

X1,X2,T,Z,V 

 

SNM 0.00 – 0.15 0–0 
Number of Retry 

when GET PUT 5Hand operation fails 

 

VBU 0.00 – 0.15 0–0 Vibration sensor's Enable Flag   

ZEM 0.00 – 0.15 0–0 On Off Flag to check the position   

ZES 0.00 – 0.15 0–0 Allowable value for the position error   

SAVEFLASH 0.00 – 0.15 0 – 0 

PARAMETER SAVE 

Saves flash memory. 

 

You should not turn off the controller power 

until memory save is completed. 

 

W 

 


